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Introduction

The year 2000 is upon us, and with its passing has brought a renewed faith not only in our existing computer hardware, but also the pioneers who maintain and write software for them. Though a fast changing and sometimes brutally competitive field, Information Technology has propelled the majority of us into a world of knowledge, memory, and speed never before realized in what we perceive as modern civilization. These words fall empty on those that dismiss the PC as another needless appliance, but to the modern disciples of digital dementia, the "appliance" is only limited to the endless possibilities of their minds. Of course, the fiscal realist also takes stock in a machine that offers light speed processing of financial and personal data. It is to both these groups that I offer Financial Manager.

The birth of Financial Manager resulted from my own need to simplify the process of bank reconciliation. I used to bounce a lot of checks! After purchasing my first PC back in 1991, it occurred to me that developing my own financial software would be a good way to stay out of trouble and have fun at the same time. I was so impressed with my software, that I decided to offer it, free of charge, to anyone with enough hard work and perseverance to actually find it amongst the over commercialized haystack of computer generated nonsense that is choking the net. I've compared Financial Manager to many freeware packages available (especially on Simtel.net) and found it to be as good if not better than those that claim the same function. 

Written for the personal computer (PC), Financial Manager is a simple account ledger that will run on either a Windows or DOS platform. It was written using the '87 version of the Clipper computer language, utilizing dBase III files with the .dbf file extension. F.M. allows you to add and change transactions associated with a bank, debtor, or any other financial accounts you have. Maybe a friend owes you money, and you don't want to forget! In the case of a bank account, there is an option that allows you to reconcile all unpaid checks against a current bank statement. Financial Manager will also sort records by date and check number.  Take time to read about the various options F.M. has to offer, use it at your discretion, and have fun!

Chapter 1 - Getting Started

As previously noted, Financial Manager was originally designed to operate on the Microsoft DOS platform, and this realization leads to follow that Financial Manager is a whimsical old dog in desperate need of iron shrapnel passed between the ears approaching speeds of the waves they once interpreted in earlier period. In this labor of thought, be assured a bridge to the modern Windows platform is within reach. Of course, you'll have to jump through lots of hoops, and climb many ladders to get there (figuratively speaking, of course).

Where this is true, the approach used by this manual include installation instructions for both Windows and DOS environments, and humbly apologizes for lack of familiarity with other operating systems such as UNIX, Linux, Red Hat Linux, or Macintosh. There also are two ways of receiving a copy of Financial Manager, unless, of course, you're clairvoyant. Remaining faithful to the conventional mechanics of computer discipline, the two modes of obtaining F.M. will be through a 3.5 inch floppy disk or a downloaded file from the following Internet site: 

www.angelfire.com/wi/dairyland/FinancialManager/fmpage.com

Unzipping Financial Manager

Weather you obtain Financial Manager from a floppy disk or the "Web", the file containing it is compressed into a format called "zip" or "zip file". A zip file contains one or several files, and must use a special program to uncompress or "unzip" the files. Many zip programs exist on today’s market including WinZip and PKZIP, and you should be aware of the zip and unzip processes local to your chosen software before you proceed. Now the veins on your temples might begin to expand by thinking you must purchase more expensive software, but rest assured that both these zip programs and others are available without charge as freeware, shareware, or some earlier evaluation version. This discussion will relate to the WinZip software. If you don't own a copy of WinZip, it can be downloaded from their Internet site. 

The zip file containing Financial Manager is called fm20.zip. As mentioned earlier, this file exists on either a floppy disk or somewhere on your computer's hard drive (probably the Windows desktop or whatever folder name you chose when the file was downloaded). Before unzipping fm20.zip, you need to tell WinZip what folder the extracted files should be copied to. The correct reply would be c:\finance\accounts. This folder must be created before the zipped files can be extracted. After you complete this process, the folder c:\finance\accounts should contain the following files: 

README.TXT

FINANCE.EXE

FINANCE.DOC

FORMAT.DBF

Again, refer to the help files residing in WinZip if your having problems extracting zip files.

If your PC doesn't load some form of Microsoft Windows upon startup (like Windows '95 or '98), then chances are it's running some version of DOS. A right pointing arrow followed by a flashing dash, or “prompt” indicates this operating system. To install Financial Manager in DOS, first create a sub-directory called c:\finance\accounts. There should be an instruction manual included with your version of DOS explaining this procedure. In the case where you can't complete this function, follow these two steps:

1. at the c:\> prompt, type md finanace

2. at the c:\>finance/ prompt, type md accounts

Since there are no versions of WinZip for DOS, you’ll have to use an earlier version of zip software such as PKZIP. Download PKZIP from www.pkware.com, and follow the help manual it offers to extrat F.M.’s files to the c:\finance\accounts subdirectory.

As you can see, installing Financial Manager is slightly more complicated than more current software packages. Ignoring the oversimplification and ease of more modern technology, one might consider the wealth of history gained, and realize the tremendous growth our digital industry has had over the past ten years. With thus having been said, you are now ready to use Financial Manager.

Running Financial Manager

Now that all necessary files have been installed on your PC's hard drive, the processes of executing or “running” F.M. are quite simple. From the Windows desktop, double left click your mouse on the "My Computer" icon. This will open another window containing a list of available drives on your computer. Move the mouse pointer to "C_DRIVE (C:)", and again double click. Now a box with a list of all folders and files on the PC's hard drive should appear. These folders and files appear as icons, which are graphical representations of the existing data. Locate the folder titled FINANCE and double click. The only folder that should show up is ACCOUNTS. After selecting ACCOUNTS with the mouse, all the files that were installed in the previous section will be listed. To run Financial Manager, simply aim at the icon labeled FINANCE.EXE and click.

As with most redundant medial tasks performed by humans, the steps building to the actual execution of Financial Manager will become more familiar with increased repetition and the passing of time. Don't get discouraged. As one of my previous coworkers once said, while plowing through endless stacks of paperwork containing expired insurance policies about to be purged, "it gets better."

Chapter 2 - New Wave Accounting

I was in a small convenience store the other day, and couldn't help but notice the unsteady movements of the man in front of me. He was about to purchase a two liter bottle of cola, perhaps to mix with the bottle of rum, vodka, or whatever form of alcohol he'd been cleansing his mind with. Maybe he was just doing a favor for his nurse who would return medicine to cure the mental ailment he was suffering from. Regardless of the circumstances, he was at a disadvantage to conduct the financial transaction about to occur. To my astonishment, he pulled a laptop computer out of the bag he'd been toting, and attached it to the cash register in front of him with what looked like a phone cord. After entering a few commands, the cash drawer of the register swung open, and the man behind it extended an indiscernible amount of cash, and our new wave customer was on his way. I asked the cashier if he wanted me to call the police, and he rudely replied: "What's the matter, buddy, were you born in a barn?"

This, of course, is a mild fictional account of something that might occur in the future. Logic would stand to reason that the wavering fellow had just been in a car accident, and was simply withdrawing money from his wired bank account to pay for the tow and damages. And this thought has a brother: If not his basic aptitude of digital futuristic banking, might he have lost the job where thus in route on the first day? 

What could be worse? The mere likelihood of his insobriety should bring forth an illegitimate cash transaction favoring the fiscally lustful slooth, and render him brokenhearted upon reconciliation with his faithful mistress. If our obedient minds loan blind trust to the common goodness of mortals, then why shouldn't it pawn a poor orphan affording conscience of a demonic fiend? A factual matter at best, the fruits of a noble economy ought not be negotiated in the armpits of the nearest 711 store. Keeping in touch with simplicity, in difference to the educated and trusted, a changing world have thus the people relentlessly battled. The pity of our ancestors is no longer cast upon Satan's enslaved and blinded crook, but the blooming and florescent light of our being. The simple masses will no longer pay duty to an overwhelmed whimp of fanfare, but give platform to a guiding manager of finance.

Schools, Tools, and Fools 

Devices prescribed by our higher intuition to ease the suffering of our toil have given evidence to a history of work. Our modern condition omits the stench of an under worked, overpaid, and increasingly lustful band of decadents. Though pathetic in nature, an exaggeration it would be to state that our obesity has in any way affected our will to compete. The sumo wrestler doesn't run in the one hundred yard dash, yet fights with bloody ferocity, giving virtue to his weight. As with such, the happy go lucky yet needful flounders of society now accompany a new device, called the personal computer. Glimpsing back in memory, zero to sixty in nine seconds was a measure of speed, but how about sixteen megahertz to six hundred megahertz in nine years sound? A new dimension has been added here, lacking conscience thought of a great many, but affecting millions. A physics scholar or modern philosopher might spend time pondering the cliché' question: If you’re in a vehicle traveling the speed of light, could you see where you’re going? Rest assured that the authoring our future's monetary and social structure allows growth for the non- competitive entity, while giving praise to the triumphant in spirit.

Is there a reason for the nonsense, or are we being led to a zeppelin of destruction echoed by the painful yet flaming picture of the Hindenburg landing on foreign soil? Will hamburgers and hotdogs taste better if the .jpg image of Britney Spear's naked body is downloaded at three hundred thousand bits per second rather than thirty-four? Though childish in nature, we should thus consider the response of society to its new "tool." But here, my friends of small type, is where the birds have eaten our trail of bread. As necessity has become the mother of invention, will it always follow that invention destroys a society that so needed her in a fleeting memory? The leverage produced with most computer functions will propel us no longer towards a goal of triumph in a futile culture, but lend favor and acceptance with other less attainable disciplines. In this case, the tool labeling associated with our new "appliance" might in turn cause a fool to its announcer!

Where to Start 

While realizing the scope of this notation, yet comprehending the exhaustive display of it's content, the details and interactive methods of Financial Manager will soon follow. As with so many natural processes, it is important to establish a beginning and end of the software's functionality. Unfortunately, due to the circumstances of financial balance, a rigid set of maneuvers cannot be plotted for each F.M. session. For instance, on Tuesdays you may want to enter all new account transactions for the previous week, yet wait till dawn on the Thursday following the winter solstice to reconcile these account entries with your bank statement. Maybe you just want to perform a search on all checks written to Walgreen’s, ensuring that the next box of condoms purchased won't overdraw your entertainment budget! As you can see, there are many different ways one may use Financial Manager.

Bounce Bar Menus and Pop-up Windows

As windows offer us a safe view of a sometimes unattainable universe, so does Financial Manager offer us bounce bar menus. The pre-mouse pioneers of silicon sanctuary remember Lotus 1-2-3 and earlier versions of WordPerfect, but the post-Pentium prowlers of the digital decade might need enrichment courses to find their keyboard's arrow keys! One may even question the fact that the escape key (ESC) will exist on newer machines. This is not to say that a mouse driven data entry package is faster than one that uses only the keyboard. In fact, many experienced office personnel would tell you just the opposite, preferring a keyed-only system as long as the software's function is specific to their business. 

Familiarity with the bounce bar menu should begin during your first F.M. session. Notice that Financial Manager initializes to the "Add" screen after you key out of the Title Screen (see figure 2.1). [image: image1.png]s cor mens)




One way to tell what screen your using is to look at the third line from the bottom, which is called the Screen Indicator Line or "SIL". This line begins with one highlighted word, called the "Screen Indicator". In this case, the Screen Indicator simply reads "Add". At this point, press the <ESC> key located in the far upper left corner of the computer's keyboard. Immediately following your action, a menu will appear just below the SIL with a "bar" highlighting the File option. To illustrate the bouncing effect of the highlighted bar, press the right arrow key, and notice how the bar "bounces" to the next option. Now press the left arrow key two times. Incredibly, the bar lands on the "Quit" option located to the far right of the menu. This phenomenon is known as "wrap around", and was originally designed to save keystrokes by offering a shortcut to the desired option. Also notice the first letter in each menu item, aside from the Sort option, is brighter than the rest. Choose any menu option by simply pressing the highlighted letter it corresponds to.

The bounce bar system is a layered system, meaning that one thing leads to another. The options in these menus are displayed at the very bottom of the screen, depending on where the bounce bar lands. For example, place the menu bar on the Edit option, and notice all the sub options that will appear in the Edit menu. These are Browse, Change, Delete, and Mark paid. To illustrate menu layering, again position the bounce bar over the Edit option, and press <ENTER>. According to plan, the Edit menu will display, allowing you to choose the edit function specific to your needs or desires. This time, however, the SIL reads "EDIT MENU" instead of "MAIN MENU". Always look to the SIL to determine how deep into F.M. you really are.

A good way to look at the bounce bar system would be to compare it to the ocean surrounding a coral reef. You, as the diver, must sink deeper and deeper below its depths to attain something of value, like a starfish or golden coin buried beneath a pirate's lost ship.

Building your own Financial History

How many words could you use to describe what happened on the job today. Does the ink flow better from the working hand, or is great writing attributed to a life a leisure? For the purpose of this piece, let's assume that no one in the world care's what other people do for a living. In fact, let's just say the only thing that matters anymore is how much money you have, how much money you owe, who gives you money, and who gets your money. In many cases, when it comes down to matters of legality, it will be your financial records that cause the demise of your downfall, or be your savior in the face of a vengeful debt collector. In addition, adding a simple payroll deposit transaction to an electronic ledger is a faster process, an important value for the busy, industrious, or carefree.

If your still reading this manual, I'll assume that your sense of humor and understanding are in good health, and maybe the only reason you have Financial Manager is because you like its pretty colors or the fact that it's a smooth operator. Despite all this, let me continue discussing how wonderful it is to have digital devices keeping track of our financial feats, as well as our money mishaps. Amongst the Internet's many attributes, is its ability to connect your home PC to that of another computer (called an internet server) through a phone line, cable modem, cellular device, or satellite dish. Some day, in the future, there might even be ways of copying information from a PC to a floppy disk, strapping the disk to a trained dog's back, and running the canine over to the nearest internet server's location where the webmaster can then upload the new account. Anything is possible, as long as other less teachable dogs don't feel ashamed of their cyber siblings.

Adding Stuff to an Account

With no further brain damage inflicted on the loving or weak of stomach, the next item on this manual's agenda will be the Add option. The Add screen is the first screen displayed after you press a key in the beginning. In other words, Financial Manager assumes you want to start a new account during initial entry of each session. This, however, is not always the case. Let's say, for instance, you want to add transactions to an account you already have stored on disk. In this example, you'll first have to retrieve the file from disk by scuba diving into F.M.'s menu system as described in the previous section. After the file has been loaded into F.M.'s memory, you then need to select the "Add" option from the main menu. 

Weather you're starting a new account, or adding transactions to an existing account, the process of entering new data is the same. In all cases, the add line will appear with a blue background and bright yellow text, with a flashing horizontal line prompt. The beginning of this line is the month section of the date field. All dates will be entered in the MM/DD/YYYY format. Go ahead and try entering a date, and you will find that the prompt automatically jumps to the check number field after the last year digit is typed. This is true of all entry fields, and the <ENTER> key should only be pressed after all inputs for the current transaction have been added. This is how Financial Manager knows that the current input is complete. Another way to jump from one input field to the next is by using the TAB keys. Pressing <ESC> will nullify the current entry line and return control to the Main Menu.

Hopefully you've found the process of adding data to an account not so difficult, but after some experience with the process, F.M. may reveal some quirks not found in other text editors. For example, the Insert and Delete keys have no function. If you spelled a word wrong in the Description field, or mistyped the Withdrawal Amount, then you'll have to use the arrow keys and space bar to overwrite the error. This phenomenon is a result of lazy software engineering on the author’s part, and a remedy will be implemented in future releases of F.M. as soon as possible. Until then, be patient and understanding with the current system.

Recording Money Matters on Movable Matter – The File Menu

One thing that separates humans from computers is that once the plug is pulled on a computer, it won't remember what happened in the past. Because of this, there has to be some way of saving and retrieving data, especially if the information is personal. Maybe you want to protect your data from a natural disaster, and having multiple copies stored in different locations would be beneficial. Financial Manager has included routines that make possible the transfer of data between the computer's memory and external peripherals. These features are found under the File Menu and include the following options: 

New

The file-new option is identical to those found in most Windows applications differing only in appearance and where it's located on the screen. Selecting "New" will cause all the transactions in the current account to be erased, and the Add screen then displays with an empty account. This should be used when you've finished saving an existing account, and want to start a new one without having to exit and re-enter Financial Manager. Like with all good software about to erase a current file, F.M. asks you to consider the question: Save current account to disk? (y/n). 

Retrieve

This menu option tells F.M. to fetch data stored on either a floppy disk (a:\) or the computer's hard drive (c:\). Selecting the Retrieve option will cause a window to appear showing all accounts in the current drive's directory (or folder). Here's where people with knowledge of DOS have an advantage. Unlike the graphics intense Windows operating system, Financial Manager and DOS display directories, sub-directories, and files in one written line. Remember that directories and sub-directories to DOS are the same as folders to Windows. If the file you wish to retrieve is in another folder, press the F1 key, and enter the new path. Unfortunately, Financial Manager will not list all available directory paths available on the current drive. You will have to know ahead of time the specific drive and path that your account is saved under. Once you have entered the correct drive and pathname for your account, or the desired pathname was already displayed, a list of files in that directory will appear. This box, sometimes referred to as a pop-up window, behaves much like the bounce bar menu. A highlighted bar controlled with the arrow keys is moved over all files in the list. If more than twelve accounts reside in the current path, F.M. allows the list to scroll up or down depending on which arrow key your using. The final step in retrieving an account file is to simply maneuver the bounce bar over the file your going to maintain, and press <ENTER>. You should now be viewing the main menu screen with the saved account's transactions listed.

Save

Use this option when you want to record any changes made to the current account. After "Save" is chosen, you will be asked to name the account in question. If your working on an account that has already been saved, that same file name will appear immediately after the prompt, in order to avoid the redundancy of re-typing the same file. As brought up earlier, the entire pathname of accounts in F.M. is displayed in the MS-DOS format rather than a Windows type structure. You can change the filename (remembering the .DBF extension), but make sure that if you also change the drive or directory that the new path actually exists. 

Directory (Not available on Financial Manager 2.0)

Copy (Not available on Financial Manager 2.0)

Although this option hasn't been written yet, there is an alternative method for duplicating files in Financial Manager. First load memory with the file you want to copy by using the File-Retrieve option. Now choose Save from the File menu, and replace the current file name with the name you want the file to be copied to. This action is comparable to the "Save As" option in Windows. 

Delete (Not available on Financial Manager 2.0)

Chapter 3 - Reconciling your accounts with a Bank Statement

A good way of establishing trust and good feelings with any financial institution is by keeping accurate records of all dealings you have with them. This includes check writing, ATM transactions, electronic fund transfers, cash withdrawals, and payroll deposits. I could name more, but wanted to give you an idea of the many different financial roles these organizations play in our lives. 

In the financial world, as with any other arena, not only the participants, but also the viewers of the interaction expect a sense of fairness. Our money is not just used as a prop to purchase goods and services with. It is also used as a device to measure our own worth in society, and as a carrot to satisfy the hunger of working class citizens. With this in mind, our focus with money doesn't concentrate itself so much with the quality of a dollar bill as much as the quantity of bills we've accumulated in our established ledgers. You can see how the difference as small as one dollar each month between your own personal records and those of your financial institution might, over time, lead to feelings of anger and resentment. In this section, I will discuss the tools Financial Manager uses to balance any saved account with a periodic statement from a bank, credit union, savings account, stock portfolio, debt collector, or whatever.

For the purpose of F.M.'s Balance option, a monthly checking account statement will be used as an example. With most bank statements, transactions are separated by type including withdrawals, deposits, and cleared checks. All checks that clear or have been "paid" will usually be listed in chronological order in a different location on the document. 

Before explaining the mechanics of F.M.'s balancing system, I want to emphasize the importance of integrity that must exist in your own financial tracking methods. Unlike a bank teller, you won't always have access to a personal computer to record a transaction immediately after it occurs. When writing a check, making a deposit, or withdrawing cash from either an ATM machine or bank teller, you should receive some form of receipt that displays the amount of money rendered. In the case of check writing, you should record the amount in your checkbook's ledger. I prefer duplicate checks, which create a carbon copy of the original to ensure that the amount is always accurate. 

Make a practice of keeping your checkbook and receipts in a secure place. A wallet, purse, backpack, or briefcase is commonly used for people in transit. Stuffing a receipt in a pocket isn't a good method for accurate bookkeeping, due to the increased probability of accidental loss. Perhaps you’re in a hurry to get to the tavern after work, and hastily grab the car keys from your front pocket that also contains a bank withdrawal receipt. The receipt falls to the ground unnoticed, and when the time comes for bank reconciliation, there will be no record of the withdrawal. A week later, thinking you have enough money in your account, you write a check to that same tavern which eventually bounces. Try explaining that to your spouse or personal banker!

I hope I didn't frighten you, but let's continue talking about personal accounting anyway. Alone now in front of your PC, set apart from the mayhem that is the modern world, gather the receipts and checkbook logs that you've accumulated during your previous industrial endeavors. No need to sort them chronologically, for F.M. already has the power to perform that task. Referring back to this manual, use the File-Retrieve and Add options to enter all new business in the checking account file you've stored on disk. Notice that after you enter a transaction, the current balance is calculated and displayed in the column marked "BALANCE".  

Marking Transactions Paid 

Getting back to the monthly bank statement, realize that F.M.'s current balance relies not only on the transactions you just entered, but the balance that your bank statement shows on the date it was issued. On most of these documents, a composite listing displays a balance from the previous month, the total amount of withdrawals and deposits in the current month, and an ending balance from the current month. Before entering the new ending balance, you must first record the checks, deposits, and withdrawals that also have also been recorded by the bank's computer system. In Financial Manager, we will use the Edit-Mark Paid option from the Main Menu to accomplish the job.

From the Main Menu, choose Edit. From the Edit Menu choose Mark Paid. An easier method is to simply type e m. The SIL should now display "MARK PAID", and a flashing cursor will appear at the beginning of the last log entry. Use the up and down arrow keys to scroll through the transactions. There is no Page Up and Page Down function for this screen, and again forgive me for neglecting those key strokes (Maybe this could be another improvement for future versions).

Using the arrow keys, find the transaction that matches the first check listed on your bank statement. When you've positioned the cursor over the found entry, press <ENTER>. A check mark will appear between the columns marked DATE and CHECK NO. This symbol indicates that the transaction has been paid by your bank account, and will not be used with other unpaid or "outstanding" transactions in re-calculating your new current balance. Repeat the same steps for all remaining items on your bank statement.

Changing Transactions

Understanding the margin of human error, discrepancies might occur between your Financial Manager's records and your bank's records. With confidence approaching one hundred percent, I will venture to say that the error should not be blamed on your Financial Manager software or the bank's computer system. Most software, including the topic of this correspondence, has proven to be virtually flawless once implemented on any standard system. Simple transistor binary addition and subtraction was one of the first applications of the modern business machine, and should be challenged last amongst all other possible causes for error. In extreme cases, an ex-girlfriend or boyfriend stealing and forging one of your checks would be more likely. This, of course, is an extreme case, and we could assume the most logical explanation to be a small tactical error by some rookie part-time bank personnel.

So as not to exhaust the circumstances surrounding the need to edit an existing transaction, I'll assume no responsibility except for that of explaining how the change will be brought about. First, call the function by invoking the Edit menu followed by the Change option. Again, this is achieved most simply by typing e c, but you may use the arrow and <ENTER> keys if you wish. Similar the Change process is that to the earlier described Mark Paid process in where a flashing cursor will identify which entry you want to edit, and the arrow keys will allow navigation through the entire account. Once you've found the errant record, press <ENTER> and the line's text appearance will be transformed into a bright yellow hue. This indicates that the previously guarded entry is unprotected, and you may then proceed with the necessary changes. Press <ENTER> again when your satisfied with what you've done.

Sorting Transactions

When time traveling, the ever present isn't always as fun as the past or future, and this can also be said when entering new data into Financial Manager. If a transaction that you forgot about occurred on Monday, but wasn't recorded in F.M. until the next month, how would you be able to find it a year later? In other words, entering financial events in order other than they took place in real time might cause confusion to a logical search approach. Because disciplined minds think linearly, Financial Manager includes a sort option to frustrate three dimensional and freethinking people looking for more information than they really need.

Since accounting is such a boring task, I wanted to take away your ability to organize data any sort of way. I know lots of people want to alphabetize, but wouldn't you rather chronologicalize? It seems much more amusing to me, so I simplified the process of ordering to one command, and this command will order all transactions first by date, then by check number (if, of course, the subject in mind is a written check, of course:)

Sort is reachable from the Main Menu, and requires no further instruction. Again, use the bounce bar method to select Sort, or type the letter o. Organize your records anytime, but a good idea to execute before reconciliation! 

Calculating Current Balance

The final step to bank reconciliation is calculating the current balance. As previously discussed, a new balance is automatically calculated during the Add and Sort processes. Only after the Edit-Change or Edit-Mark Paid functions are performed will you need to use Financial Manager's Balance option. 

On your monthly bank statement, find the area where monthly totals are listed. There should be a balance amount for both the beginning and ending dates of the month. If you consistently use the methods described in this manual, then the Bank Date and Balance displayed on F.M.'s main screen (see figure 3.1) should match the month's beginning values on your bank statement. [image: image2.png]checx s e w0
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Now open the balance option by typing "b" from the main menu. An input prompt should now appear where the previous month's balance is displayed on the screen. Type the month's ending date and balance that's listed on the bank ledger document, and press <ENTER>. A new current balance will be computed by taking the difference between all unmarked transactions listed in current memory and the bank balance just entered.

Chapter 4 - Seek Out and Find - The Search Option

Building a large database of financial records is one thing, but finding certain transactions at a later date is another. Obviously, if you knew the date or check number, a simple sort and browse session with Financial Manager would be enough to recall the record, since the Sort option automatically orders the information by date and check number. Let's say, however, that's its tax time, and you need to round up all the contributions you selflessly gave to various charities over the past year. Perhaps your applying for a credit card, and the bank needs to know your monthly income to determine the amount of credit it can offer. Maybe you just want to know exactly how much money you spent during the Christmas shopping season this year as compared to last. All of these inquiries can be accomplished with the Search option.

Search Expressions

As with the written language, search expressions in F.M. are formed and governed with a group of words and symbols. No sentence is complete without an object and an action, and no search may be performed without two values and an operator that compares them. Although this approach may at first confuse people with weak mathematical backgrounds, I assure you that it makes Financial Manager much more powerful.

What does it mean to say that you want a list of all bank deposits made in the month of December 2000? Breaking down the previous question, we can deduct that the only two search areas we're interested in are the date (DATE), and the amount of deposit (AMT DEPOSIT). In other words, we want F.M. to find all transactions with a month equal to 12, a year equal to 2000, AND have an amount of deposit greater than zero. Concentrating on the date only, we could also say that we want records that occurred after the last day of November 2000, but also occurred before the first day of the new year. It's a tricky way of saying the same thing, but just as effective. This may seem relatively straightforward for some, but converting this idea to something that Financial Manager can understand is more difficult. 

Expression Symbols

Now that we have a rough idea of how our Boolean expression should look, we must use the conventions designed by myself, the author, to program Financial Manager with stimulus it will understand. Examine the expression symbol table on the Search Edit screen. F.M. uses symbols rather than the ideas they represent to save space on the screen. A picture says a thousand words, and many people have taught themselves to rely on short visual indicators rather than inflicting self torture by reading through a combination of less powerful words hooked together to convey the same idea as one stroke of the pen (or screen drawing utility). 

The Contains (CT) Operator

Most readers at this level have some understanding of greater than, less than, or equal to, and I won't go into detain explaining them. The Contains symbol (CT), however, is not a traditional Boolean operator. This symbol is only used to evaluate expressions associated with the DESCRIPTION search area, because it's action compares a segment of alphanumeric characters to the entire Description field. To illustrate with an example, you may want to find all payroll deposits from a previous employer named "ACME Computer Disks", but the only part of the name you can recall is "disk". By using the CT operator, you can force Financial Manager to hunt for all transactions where the string "disk" occurs. The search expression will look like this:


DESCRIPTION CT disk

and the search output for the description field might look like this:

      payroll/ACME Computer Disks

      payroll/ACME computer disks  

      cash for 20 diskettes sold  

In this example, F.M. found all payroll deposits made for ACME Computer Disks as well as another non-related transaction described "cash for 20 diskettes sold". That's because the word "diskette" contains the string "disk." Also notice that the search isn't case sensitive, meaning that both capital and small case letters are interpreted the same.

Editing Search Values

Access the Edit Search screen by typing an "s" or "S" from the main menu. You should now be viewing a black screen with green trim and lettering (see figure 4.1). [image: image3.png]7 o comina e o
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F.M. uses colors as well as the SIL to make you aware of where you are in the program. Notice that the search screen is broken into two elements - Search Areas and Search Expressions. You may be familiar with search engines on the Internet, such as Alta Vista, where vague words and phrases are entered on one line to scan the entire Internet. With Financial Manager, you can be as specific or vague as you want with your query, because it allows you to enter a search expression for each field in the record.

Upon entry into the Search Edit Screen, you can see that each field of the transaction record has its own separate line, and the first input space for each line is for the expression symbol (see section titled "Expression Symbols") that initially is blank. Financial Manager will not allow a typed entry of these symbols. Rather, you must use the arrow keys to toggle through the list of symbols displayed to the right of the screen. If you choose not to query on a certain search field, leave the first operator field blank, and the entire line will be erased. Use the <TAB> or <ENTER> keys to jump to the next entry points.

Depending on how familiar you are with database query languages such as SQL, it is obvious that F.M. has limitations to the extent of the search. For each search field, there can only be two search expressions conjugated with the "AND, OR" operators, and the entire group of search areas are assumed to be "ANDed" together. When editing multiple expressions in the same line, you can select the conjugating verb (AND, OR) by using the arrow keys just like selecting the operator. In the previously mentioned example, the output will list deposit transactions that occurred in the month of December. We need to tell F.M. to find dates on or after December 1st, AND on or before December 31st, AND have deposit values greater than zero. Assuming the year in question is 2000, the query statement will look like the one show in Figure 4.1.

Notice that no values for CHECK NUMBER, DESCRIPTION, and AMT WITHDRAWL were entered because they are insignificant considering the scope of the search. Also notice that DESCRIPTION fields are spread out over three lines, because each entry allows up to 30 spaces, and the size of letters on the screen can't fit on one line. There are other, more creative ways to cope with this problem, but again the author of this text and software is too unambitious to implement them. Besides, there's no sense in reinventing something that has already been done, or beating a dead horse, for that matter. 

Viewing Search Results

After you've entered the parameters to guide the search process, Financial Manager must then do the work of compiling and displaying the results. Press <ESC> when your finished editing query values, and control of the program will return to the Search Menu. The available options now are Edit Search, Search Account, and Search Multiple Accounts. Since we've just completed editing our search, and the Search Multiple Accounts option hasn't been written yet, our only logical choice for finding and viewing the output would be "Search Account". Go ahead and select this option by pressing "s" or "S", and the Search Results screen (Figure 4.2) will appear.
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Look in the upper left portion of the screen, and you will realize that F.M. tells you how many records were found. Also, the specific query that was entered in the previous screen is also shown directly below these totals. Moving to the right, a box displays showing the difference between all deposits and withdrawals for the selected transactions. This is called the "Search Totals" box, and was added specifically for situations where you wanted to know either the sum of all deposits or withdrawals for specific dates or descriptions. 

The rest of the display window looks very similar to F.M.'s main screen, with a few minor differences. The screen color, obviously, is different, as well as the number of records shown at one time. Financial Manager's browse screen displays 13 transactions, where the search shows only 10 at a time. What's especially interesting to note is that when browsing search results, you may scroll by page (using the <Page Up> and <Page Down> keys), where the other mentioned scrolls by line. A message in the lower right of the window identifies what page is being viewed.

HINT: If you want Search to select all records in the account, leave the search edit screen blank. This will allow you to scan through transactions much more quickly, because the search output scrolls by page instead of line.

Summary 

As I mentioned earlier, Financial Manager started as an experiment intended solely for my own personal use. With so many other similar software packages available today, you might be wondering why I bothered uploading it to the web. Though I may not be as wise as some of my readers, it seems obvious to me that choices need not be made if there are no alternatives. Take it for what it is. If you’re a teacher or a parent, feel free to edit, copy, or use the entire package at your own discretion. As for the young readers, I hope your perseverance has paid off, and I encourage you to stay in school while constantly learning. Most of the ideas and functions displayed here have been expressed before, but anything new found in it is for the best. Look to the Street Sheet for future upgrades, and keep surfing! -M.L.R.

